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Tutorial: Simulated Bathymetric Survey 

This tutorial provides you with a brief introduction to some of the basic capabilities offered by 

the WinFrog integrated navigation and data management system. It also uses step-by-step 

directions to guide you through the configuration and use of some basic navigation and survey 

functions in WinFrog. These instructions assume that you have installed WinFrog (at the root 

level of the C: drive) and are ready to begin demonstration exercises. It is also assumed that you 

are familiar with the operation of Microsoft Windows and have some familiarity with the use 

and purpose of integrated navigation systems. See the appropriate chapters in the WinFrog 

User’s Guide for more details regarding all aspects of WinFrog operation. 

At the beginning of each new project, essential components of the WinFrog integrated 

navigation software must be properly configured. Though each project or application has 

different requirements, some standard procedures must be followed before WinFrog can be used 

successfully. 

In this tutorial, you are guided through the procedures used to set up a typical WinFrog 

configuration and will then generate data for a simulated project. The goal of this tutorial is to 

give you a “feel” for the program and how you would use it in the field. 

Procedural Steps 
Here are the steps to follow in WinFrog to collect data in a typical bathymetric survey: 

 Configure Geodetics  

 Configure Units of Measure 

 Create Working Files  

 Create Working Directories 

 Configure Peripheral Devices 

 Configure Vehicles 

 Configure Displays 

 Create Survey Lines 

 Configure Events  

 Collect Data  

 Check Data 

 Process Data (using Ribbit) 
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Sample Project 
Your client requires a bathymetric survey of a specific region of San Diego Bay, California. 

This project will be identified as Project1. 

The Geodetic Datum and Map Projection to be used are the North American Datum 1927 

(aka NAD27) with the California State Plane Coordinate System (SPCS) Zone 6. Datum 

Shifts to be used are as follows (Working to WGS 84): 

   dX: -8.000m      dY: 159.000m    dZ: 175.000m 

The client has specified data collection at 20 foot intervals along lines spaced every 20 feet. The 

survey boundaries are specified as follows (SPCS CA Zone 6): 

 Northwest corner: N 244 000.0, E 1 734 000.0 

 Southeast corner: N 243 000.0, E 1 733 000.0 

The figure below represents the dimensions of the survey vessel, LOCATOR. 

 

There are three peripheral devices on the vessel:  a simulated GPS receiver, a simulated gyro, 

and a simulated echosounder. 
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First Steps 
Before initiating any data collection, you must configure WinFrog for the project. Although 

each project has its own unique demands and requirements, there is a common approach used 

for the WinFrog configuration. Note: Although this tutorial utilizes simulated devices, you 

would still follow the same routine to configure a real project.  

The first step is to launch the program either in “demo” or “real-time” mode. (See Starting 

WinFrog in Chapter 1: Introduction for more details.) Many of the pre-project configuration 

requirements (such as configuration of Geodetics and creation of Working Files) can be 

completed before getting onboard the vessel by using WinFrog in “demo” mode. Only the 

addition of devices to a vehicle’s position is prohibited. 

If this pre-project work is performed on a computer other than the one to be used on the project, 

you must remember to transfer all required files (including the WinFrogini.wfg file) to the 

appropriate (similar) location on the working computer system. 

Geodetics 
“Geodetics” are the parameters that describe the mathematical shape of the earth and need to be 

configured in WinFrog early in any project’s preparation stages. A “Geodetic Datum” is a 

specific coordinate reference frame to which geodetic positions are referenced. A Geodetic 

Datum is defined by its Reference Ellipsoid and the location of its origin. If you are using a 

GPS receiver for positioning and have selected to use a datum other than WGS84 (the datum to 

which the GPS coordinates are referenced), you must also enter the Datum Shift values. See 

more information on Datum Shifts below. 

It is necessary to know which Geodetic Datum, as well as which Map Projection will be used 

on a project. Map Projections are used to convert coordinates from the earth’s spherical shape 

to a flat (plane) surface. 

Several common Geodetic Datums and Map Projections are available as pre-configured 

options in WinFrog. WinFrog also has the capability to accept user-defined systems. 

Configuring the geodetics must be done at the start of the project so that all Survey Lines, 

Waypoints, Picture data, and Vehicle Positions entered refer to the correct reference system. 

The importance of setting geodetics properly cannot be overstated. Setting geodetics 

improperly results in surveying an erroneous location or surveying a location different from the 

location you believe you are surveying. Errors made in specifying geodetic constants will be 

carried throughout an entire survey and may be very difficult, if not impossible, to undo. 

Therefore, it is imperative that you understand the implications when configuring or modifying 

the geodetic constants and ensure that all values are set correctly. It is crucial that the geodetics 

are configured carefully before the project begins. 

To Configure Geodetics 

1 From the Configure menu, choose Geodetics. 
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Start in the General Projection dropdown menu. Scroll through the menu to see the nine 

pre-configured selections. Notice that these selections are really Datum selections (map 

projections in conjunction with commonly used geodetic ellipsoids). One of the available 

options is User, which allows you to configure your own custom projection/datum 

parameters as required.  

2 For our sample project, it was specified that the NAD27 Datum will be used with the 

California State Plane Coordinate System (Zone 6) . Scroll through the General 

Projection dropdown menu and select SPCS 27. 

3 Scroll through the Specific Projection dropdown menu and select California 6. 

This zone is used for work in the area around San Diego, California. The Map Projection 

Parameters portion of the Configure Geodetics dialog box shows the particular 

parameters of the SPCS Zone 6 projection. These are fixed parameters and do not require 

any editing or modifications.  

Note: the unit of measure used with this datum is the US Survey Foot. 

Because you are using the NAD27 datum and not the WGS84 datum (as specified in the 

General Projection), it is now necessary to edit the Datum Parameters in the Configure 

Geodetics dialog box, particularly to define the working ellipsoid parameters and its 

relationship to the WGS84 Ellipsoid. The SPCS 27 datum uses the Clarke 1866 Ellipsoid 

as its reference model and no modifications are required to this ellipsoid’s parameters (i.e.: 

semi major axis and inverse flattening). 

The Datum Shifts between NAD27 and WGS84 are different for every location and are 

required in WinFrog to correct the positional information received from the GPS receiver 

(which refers to WGS 84) to the Working Datum, in this case NAD27. Datum shift values 
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are sometimes specified by the client to provide consistency with previous projects. Other 

projects may require you to derive the datum shifts by using GPS observations on a local 

datum monument, or by referring to a National Imagery and Mapping Agency (NIMA) 

publication. 

The following datum shifts are specified for our project: (Working to WGS 84): 

dX: -8.000m                       dY: 159.000m  dZ: 175.000m 

 

To view the entered Datum Shift values, click the Edit button in the Datum Parameters 

portion of the Configure Geodetics dialog box to see the Datum Parameters dialog box. 

 

When the NAD27 and SPCS Zone 6 options are chosen (as described above), WinFrog 

provides default datum shift values for NAD27 in the San Diego area, as per NIMA 

specifications. 

In this case, the default values match those specified in the project outline, so no changes 

are required. You must always confirm that you are using the correct signs (positive or 

negative) for all datum values.  

Note: some datums may require scale and rotation corrections, as well as the datum shifts. 

4 Click OK to close this dialog box and OK again to close the Configure 

Geodetics dialog box. 
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Units of Measure 
Rather than having to specify a unit of measure or coordinate type each time you make an entry, 

you can configure WinFrog to default to the correct type of value. It is best to do this at the 

beginning of the project. 

 

To Configure Units of Measure 

1 From the Configure menu, choose Units. 

2 On the General tab in the Distances area, click the US Survey Feet option. This allows us 

to be consistent with the units used in the specified SPCS Zone 6 datum/projection. 

Note: the US Survey Foot differs very little from a standard foot. 

1 US Survey Foot = (12/39.37)m = 0.3048006 meters 

1 Standard Foot = 0.3048 meters 

The difference between these units of measure is only 0.01 feet at distances of 10,000 feet. 

Obviously, for most entries, this difference will have little affect. 

Choose the US Survey Feet option for Waypoints and Survey Line too. 

3 Grid (Northing and Easting) coordinates were provided for this project, rather than 

geographical coordinates (latitude and longitude). The default coordinate type is Lat/Lon 

and needs to be changed for this project. Select the Coordinates tab of the Configure Units 

window and click the Grid radio button to change the Default Coordinate Type. 
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4 Select the Calculations tab. All line tracking values, specifically Distance Down Line and 

Offset tracking, should typically refer to True calculations. Click the True radio button to 

change this option. 

 

5 Click OK to save the changes and close the Configure Units dialog box. 
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Working Directories 
Before a project starts, it is prudent to setup and organize your Working Files and Working 

Directories so project data can be easily found and retrieved. 

The Working Directories are where WinFrog stores and retrieves raw data and generates data 

for Networked Smart Remote systems. 

You can select an existing directory or create a new directory to be a Working Directory. 

Again, in terms of organization, it is best to have just one main Working Directory for each 

project. In WinFrog, this is referred to as the Filing directory. Subdirectories can be added 

within this file, if required. 

To Define a Working Directory for a New Project 

1 From the File menu, choose Select Working Directories. 

The Working Directories dialog box is used to tell the program where to store your data. 

Looking at the Filing Directory field, you notice that there is already a default directory for 

data storage, C:\NAVDATA. The default directory for all data storage is C:\NAVDATA 

because the Filing Directory radio button in each data area is clicked. Notice that other 

radio buttons could be clicked in the data areas and that any directory, or directories, could 

be named to store these data. For this sample project, you will assign one specific directory 

for all data storage - C:\Project1. 

2 In the Filing Directory field, type C:\Project1. 

3 Click OK. WinFrog now creates a new directory named Project1 on the C drive. 

4 From the File menu, choose Select Working Directories again. 
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Confirm that the name of the Filing Directory in each data field now reads C:\Project1. 

5 Click OK to close the Working Directories dialog box. 

Working Files 
After setting up the Working Directories, you must choose or create the “Working Files.” 

Working Files are used by WinFrog to store data and to provide waypoint and survey line 

information, etc. WinFrog creates different types of Working Files to contain these different 

types of information. All files created by WinFrog are easily identified by their unique three 

letter file extensions. 

Types of Working Files  File Extensions  

Survey Lines PTS 

Waypoints WPT 

Data files list (list of Data [.DAT] files) ALG  

Seismic_Receiver (list of Receiver [.RCV] files) ALL  

Seismic_Source (list of Source [.SRC] files) ASC 

Logs LOG 

Picture PIC 

Charts RML 

CRDD Database MDB 

These files (with the exception of the chart and CRDD database files) are all text based (ASCII) 

data files created by WinFrog with the data written in a WinFrog-specific format. 

Some files, specifically graphics and database files, are not WinFrog-specific. The format of the 

data in these files was specified by their third party creators. WinFrog was modified to use these 

“industry standard” formats. 

WinFrog can access Working Files from anywhere on the computer, but it is best to place the 

Working Files in the Working Directory in order to keep the project organized. 

To Define the Working Files  

1 From the File menu, choose Select Working Files. 
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By default, the Survey Line radio button is selected. 

At the bottom of the Working Files dialog box, notice the default name of the survey lines 

file (surline) and in which directory it is stored (C:\ NAVDATA). You will want to change 

both. You’ve already set up a specific directory for our sample project called Project1; 

that’s where you will create the Working Files. 

It is usually not necessary to create all of the listed Working Files. For this tutorial (and 

most simple hydrographic projects) you need to create only the following Working Files: 

Survey Line (.PTS), Waypoint (.WPT), and Data (.DAT). 

2 With the Survey Line radio button still selected, type Proj1 in the File field. 

3 In the Directory field, type C:\Project1. 

4 Click the Waypoint radio button. 

5 Type Proj1 in the File field. 

6 Type C:\Project1 in the Directory field. 

7 Click the Data radio button. 

8 Type Proj1 in the File field. 

9 Type C:\Project1 in the Directory field. 

10 Click OK. 

Note: If you had already created the required file types, it may be quicker to use the Browse 

function to locate the files and specify them as Working Files. 
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I/O Devices (Peripheral Devices) 
The next step is to define which I/O devices (also referred to as peripheral devices) you are 

going to use in your project. WinFrog uses the computer’s serial ports to input information from 

many devices. For example, if the computer is configured with a 16-port Digiboard
TM

 serial 

card, WinFrog can read data from 16 different devices. The devices must be correctly wired to 

the serial port (typically using the RS232 protocol) and correctly (internally) configured to 

output the desired information with the desired communications protocols. 

For this tutorial, we will add three I/O Devices: a Simulated GPS Receiver, a Simulated 

Gyro, and a Simulated Echosounder (Sounder). (The terms sounder and echosounder are 

used interchangeably throughout this document and the industry.) Since WinFrog has the 

capability to configure more than one vehicle, the process of adding devices requires two 

distinct steps. 

First, the devices are added to WinFrog. Some I/O devices may require a “generic” 

configuration at this point. Next, the I/O devices are added to the desired vehicle. Most I/O 

devices must be edited again at this point to suit the unique application on this vehicle. 

To Add Peripheral Devices to WinFrog 

Although we are using simulated devices for this exercise, the steps indicated below are the 

same for adding “real” devices to WinFrog. 

1 From the Configure menu, choose I/O Devices… > Add. The Add Device window 

appears, as seen below. 

 

2 In the Select Devices scroll box, click on the “+” symbol beside the GPS group name. A list 

of all the GPS receivers that can be used by WinFrog is presented. 
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3 Double-click on the SIMULATED device (or click once on the device and then click the 

OK button). 

You’ve just added the Simulated GPS device to WinFrog. If you had added a “real” GPS 

device, a Device I/O Parameters window would have opened at this point, requiring you to 

select the specific communication parameters (baud rate, data bits, parity, and stop bits) for 

that device. 

Add the two other devices in a similar manner. 

6 Select Configure > I/O Devices… > Add. 

The same Add Devices dialog box opens as it did in Step 1. 

7 In the Devices: scroll box, click on the “+” symbol beside the Gyro group name. A list of 

all the gyros that can be used by WinFrog displays. 

8 Double-click on the Simulated gyro device. 
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9 Repeat these steps to add the Simulated Sounder receiver from the SOUNDER device 

group. 

Once the I/O Devices are added to WinFrog, they must also be added to the vehicle. This step 

occurs after the vehicle is configured and is detailed below in the section titled Defining the 

Vehicle’s Data Source and I/O Devices. 

Viewing the I/O Device Data 
WinFrog’s I/O Devices window displays the data being received from the interfaced devices. 

This window should always be visible to ensure that the correct data are being consistently 

received by WinFrog. 

This window also provides you with a right-click shortcut to add a new I/O Device (Add I/O), 

edit the device’s communications parameters (Edit I/O) or use the generic configuration 

(Configure Device) should the device’s configuration require modification. Until you are 

familiar with the devices in WinFrog, it is wise to check the configuration of all devices added 

to WinFrog. 

To View the I/O Devices Window 

1 Select the main menu item View > I/O Devices. 
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The top section of the window displays all of the I/O devices that have been added to 

WinFrog. The bottom section shows data from the currently highlighted device. 

In order to configure a device, edit its I/O parameters, or delete the device, highlight the 

device and then click the right mouse button. Choose the appropriate option from the 

dropdown list. 

 

As mentioned above, you should check the configuration of each device when you add it. Note: 

not all devices will require configuration at this level. For this sample project the only device 

that can be configured is the SimGPS device.  

2 Right-click on the SimGPS device and select Configure Device. 

3 Choose the default Simulated (99) GGA Status Flag option. 
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4 Click OK to save your selection. 

5 In real-time operations, you should leave the I/O Devices window open so that you can 

quickly check to ensure that the devices are updating correctly. If you feel that you need to 

see the data from more than one device at the same time, you can open additional I/O 

Devices windows. 

Configure the Vehicle 
The next step is to configure the vehicle. WinFrog’s default configuration contains only one 

vehicle, aptly named Vehicle 1. WinFrog supports up to 25 independent vehicles, each of which 

can have their own name, size, color, offsets, and devices. 

There are no limits to the number of I/O devices that can be added to a vehicle. You can have 

multiple GPS receivers, gyros, etc. attached to a vehicle. In those cases where there are more 

than one of the same I/O device type, you must decide which device will be the Primary and 

which will be the Secondary device. 

Note: an I/O device can also be added to more than one vehicle. This functionality is rarely 

used for anything other than simulated devices. 

For this sample project, rather than adding a new vehicle you will modify the default vehicle. 

To Configure a Vehicle 

1 From the Configure menu, choose Vehicles. Vehicle 1 is highlighted in the Vehicles 

window. (A vehicle must be highlighted in order to be edited.) 

There are 11 configuration options presented in the Configure Vehicles dialog window. For 

typical (simpler) projects it is not required to select all options. The following paragraphs 

detail only those options that must be addressed now, specifically Configure Offsets, 

Configure Vehicle Outline, Configure Vehicle-Devices, and Vehicle Presentation. 
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The Setup Data Events, Waypoint, and Line Tracking features are addressed in the 

sections discussing real-time eventing and tracking. See the appropriate sections in the 

WinFrog User’s Guide for more information on the other configuration options. 

2 Click the Vehicle Presentation button to display the Vehicle Presentation window, as 

seen below. Note: most of the options in the Vehicle Presentation window default to the 

desired settings. 
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The Vehicle Window Data field defaults to On, which enables you to see this vehicle’s 

information in the Vehicle Text window. 

The Event Generation field defaults to Event Primary to specify that this vehicle will be 

used to generate automatic events. 

The Cable Laying field defaults to Off. This requires change only if the Cable 

Management Module is being used. 

3 In the Name field, type the name of the vehicle. In this case enter Locator.  

4 In the Graphics Outline section Color field, select Edit and choose the desired color. 

5 The Graphics Trail field defaults to On. This specifies that the “trail” will be drawn on the 

Graphics screen, showing where the vehicle has been. Modify the values in the Interval 

and Trail Length windows as desired. 

6 The settings of the other presented options (such as Profile Window, Anchor Fairleads 

and Hazard Alarm) are of no consequence for this tutorial. See the appropriate sections in 

the WinFrog User’s Guide for details about these features. 

7 Click OK to close the Vehicle Presentation window.  

Vehicle Dimensions 
The next step is to define the dimensions of the Locator vehicle. WinFrog is pre-configured 

with a default vehicle shape, but you should always measure the dimensions for the vessel you 

are using and enter them into WinFrog. This aids the pilot in real-time navigation and also helps 

confirm Device and Tracking Offset entries. In this case, we are provided with the Locator’s 

dimensions (see the sample project page). 

All dimension (and offset) measurements entered in WinFrog are made from a reference 

position on the boat, referred to as the Common Reference Point (CRP). Typically, this is the 

position of the GPS antenna, but it can be any point on the boat. For example, it could be 

referenced to the echosounder transducer, the main mast, the center of the boat, etc. Once the 

location of the Common Reference Point has been established, all Dimension and Offset 

measurements must be made from that location. 

To Configure a Vehicle’s Dimensions  

1 With the Configure Vehicles window still open, click the Configure Vehicle Outline 

button. The Configure Vehicle Outline window appears. 

2 In the Entry area, select the Ship radio button. This allows for a simplified entry of a 

generic ship shape. The Outline and Graphical options allows you to enter a very detailed 

shape, but this is a much more involved process and is usually not necessary. 

3 Change the values in the Width Of and Origin To fields so they match those settings from 

the vessel’s specification sheet, as provided. 
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Note: the word ”origin” in Origin To refers to the CRP and that all values in this window 

are entered as positive values. 

4 Click OK to close the Vehicle Outline dialog box and save the entries. 

Defining the Vehicle’s Data Source and 
Devices 
The next step is to define the vehicle’s Data Source. The Data Source selection tells WinFrog 

from where it will receive its information. A vehicle can obtain its data from real-time devices, 

radio telemetry networks, computer networks, simulators, previously recorded files, or from 

layback calculations relative to another vehicle. 

Usually, the data being used by a vehicle are from a real-time data source. On larger operations, 

where there are computers networked together, Smart Remote systems will use the Network 

data source. Some multiple vessel operations will utilize the radio telemetry systems to send and 

receive data. (In this case, the Telemetry data source is used). 

To Define the Vehicle’s Data Source 

1 With the Configure Vehicles dialog box still open, click the Configure Vehicle-Devices 

button. 
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2 In the Data Source area, make sure the Real-Time radio button is selected. 

With the Data Source now defined as Real-Time, you must define which of the real-time 

devices (previously added to WinFrog) will be added to the Locator’s Device list. 

 

3 Click the Add button at the bottom of the Configure Vehicle-Devices dialog box. 

4 The Select Data Items window displays, showing all of the devices that were added to 

WinFrog in the Available Data Items list. In this case, we will add all of the listed devices 

to the Locator. Highlight the item that you want to add.  

5 Click OK to complete the step. Repeat Steps 4 and 5 until all of the required devices 

(SimGPS, SimSounder, SimGyro) are listed in the Configure Vehicle-Devices > Devices 

window. 

6 As mentioned above in the Adding Devices to WinFrog section, since no two vehicles are 

exactly alike (in terms of where the devices have been located or how they will be used), 

each device must be edited if it is added to a vehicle. 

Different devices require different parameters to be modified to suit the particular 

application. 

For example, in order for the incoming positional information to be related to the correct 
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location on the vehicle, you must tell WinFrog where the GPS antenna is located in relation 

to the CRP. 

Highlight the GPS, SimGps, Position device in the Configure Vehicle-Devices dialog 

box, then click the Edit button. 

7 The Configure Position dialog box displays. The Calculation options are for when more 

than one positioning device is added to the vehicle. Only Primary devices are used to 

provide a vehicle’s position. Data from Secondary devices (of any type of device) are not 

used in calculations. The information from those devices is only monitored. 

In our case, and in most cases, only one device of each type is added to a vehicle. 

Therefore, each device added to a vehicle should be designated as Primary. 

 

8 Under the Graphics area, click the On radio button. This will display the GPS antenna’s 

position on the ship in the Graphics window. 

9 In the Elevation entry field, select Off. On is only used if you are using a high accuracy 

(mm level) RTKGPS system. This option relates water depth values to the GPS ellipsoid. 

10 The Accuracy and Code values do not typically require change from the defaults. 

11 In the Offsets area of the Configure Positions dialog box, you must enter the offset from 

the CRP to the GPS antenna. These Offset entries must also include the correct sign to 

indicate the direction of the offset. 

Referring to the provided vessel diagram, you see that the Fore/Aft offset is 2.0 feet aft of 

the CRP, so enter - (negative) 2.0 in the Fore/Aft entry window. Enter 15.0 in the 

Port/Stbd entry field. 

12 In the Height entry field, type 10.0. This is the height of the GPS antenna above the vertical 

reference. This is only used if an attitude sensor is attached to the vehicle in which case the 

GPS antenna position is reduced to the vertical reference “zero”. 

13 Click OK to confirm these entries and return to the Configure Vehicle-Devices dialog box. 

14 From the Devices list, select GYRO,SimGyro,HEADING and click Edit. 
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15 The Configure Gyro dialog box displays, as seen below. 

 

Ensure that the gyro is designated Primary. 

A Heading Offset is usually required to make the data from the gyro match the vessel’s 

actual heading. This is a result of the gyro device’s “zero” reference mark not being 

perfectly lined up with the vessel’s centerline. A simple method of determining the offset is 

to run the vessel at (or near) its maximum speed and compare the Course Made Good 

(CMG) to the vessel heading. Ideally, they will be the same. If they are not, calculate the 

difference and enter the value in the Heading Offset window. The Offset value is added to 

the value being received from the gyro device before the data are applied to the vessel. It is 

not necessary to enter a value in the Heading Offset field for the sample project. 

The Heading Filter and Heading Gate are typically not required unless the data from the 

gyro is somewhat unstable. Leave these options set to Off. 

Click OK to confirm the entries and to return to the Configure Vehicle-Devices dialog box. 

16 Highlight the Sounder, SimSounder, Bottom Depth device in the Configure Vehicle-

Devices dialog box, then click the Edit button. 
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17 The Configure Sounder window appears, as seen above. For a typical survey you can 

leave most of the options at the default settings, checking the following to ensure that they 

are correct: 

• Designate the sounder as Primary. 

• The Apply Tides button will only work if a tide gauge or predicted tide file is 

added to the vehicle. In this case, leave this set to No. 

• The Soundings for Profile options configure the use of sounding data in 

WinFrog’s Profile window. By default, the Abort Saving Data button is 

checked. This setting is fine for the sample project. 

• The application of Offsets to an echosounder’s data is often misunderstood. The 

Fore/Aft and Port/Stbd entries are used only for graphical representation 

purposes and are not used except to plot (in the Graphics window) where the 

echosounder is located. However, the Depth offset value is extremely important. 

Most echosounders are capable of outputting various types of depth data. Depth 

Below Surface (DBS), Depth Below Transducer (DBT), and Depth Below 

Keel (DBK) are the most common data types. You must know what data are 

being sent from the sounder, then enter the Depth value here to ensure that the 

depths recorded in WinFrog will be referred to the water surface. 

 Note: sounder depths are entered as positive values. In this case, enter 10.0 ft. 

 

18 Click OK to close the Configure Sounder dialog box and return to the Configure Vehicle-

Devices dialog box. 



WinFrog User’s Guide – Tutorial  T-23 

19 Click OK to close the Configure Vehicle-Devices dialog box and return to the Configure 

Vehicles dialog box. 

Vehicle Tracking Offsets 

Due to the physical restrictions often encountered when installing peripheral devices, such as a 

GPS antenna or echosounder on a vessel, it is usually required that a Tracking Offset be 

established and enabled for real-time tracking/data recording. Tracking Offsets allow you to 

correlate the GPS antenna position to any point on the vehicle. 

For example, during data collection on our sample project, you will want to track and record the 

position of the echosounder. Another example might be if you were dropping divers into the 

water over a specific point on the bottom. In this case, you would want to track that point on the 

vessel where the divers jump off so that you can place the divers as close to the intended 

waypoint as possible. 

Instead of constantly changing the required Tracking Offset values, WinFrog has an Offset 

table where you can configure and save up to 15 different entries. This allows you to quickly 

choose a Tracking Offset from the table as required. 

Note: only one Offset can be tracked at a time. 

Do not confuse the Tracking Offset with the Vehicle Shape Offset or Device Offsets. The 

Vehicle Shape Offsets are simply for the presentation of the vessel in the Graphics window, 

while the Device Offsets are used to relate all devices to the vessel’s CRP. The Tracking 

Offset establishes what point of the vessel will be tracked and, hence, what coordinates will be 

stored during eventing. 

As mentioned previously, all of the offset and dimension measurements you enter in WinFrog 

are made from the CRP on the boat. 

To Configure a Tracking Offset 

1 With the Configure Vehicles window still open, click the Configure Offsets button. The 

Configure Offsets dialog box opens, as seen below. Initially, all of the offset entry 

windows are empty. 

2 In the Name area, enter the name of the offset point. For our example, enter the name Echo 

Sndr. From the provided measurements (see the ship diagram), the Fore/Aft offset of the 

echosounder is -50.0 ft, Port/Stbd offset is -10.0 ft. Enter 0.0 for the Elev offset. 

3 Check the Trail option so that you can see a trail of “bread crumbs” coming from this point 

on the Graphics window. (See Graphics Trail configuration under the Configure 

Vehicles > Vehicle Presentation option for more Graphics Trail configuration options). 
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4 Check the Plot option so that you can see a small circle (along with the Offset Name) 

plotted on the Graphics display showing you where the offset is located on the vessel. 

5 At the bottom of the Configure Offsets window, select the Use Heading radio button. This 

is the most accurate choice (and sometimes the only valid choice). Unless the vessel is 

constantly at speed and the CMG (Course Made Good) is the same as the vessel’s 

heading, the CMG value will fluctuate in every direction, between positional updates. 

These fluctuating data cannot be used for accurate Offset position calculations. 

6 Turn On the Echo Sndr offset.  

Note: this has several implications: 

• The coordinates displayed for this vessel in the Vehicle Text window now refer 

to this offset point. 

• All tracking information (distance/bearing to a waypoint or line tracking 

SOL/EOL/Offtrack data) now refers to this Offset point. 

• The coordinates recorded in the automatic events data (.DAT) files will refer to 

this Offset point. 

 

7 Click OK to close the Configure Offsets dialog box and save the entries. 

8 As mentioned above, the other options in the Configure Vehicles window are addressed 

further in the WinFrog User’s Guide. For now, click Close to close the Configure Vehicles 

dialog box. 
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Vehicle Text Window 
The Vehicle Text window displays real-time information in text form for all WinFrog vehicles. 

This window is user-configurable and can include information such as the vehicle’s name, 

position, heading, and speed, as well as a host of other data. The Vehicle Text window also 

offers shortcuts to various configuration options. 

One Vehicle Text window can be toggled to display information for multiple vehicles or, 

alternatively, you can open multiple Vehicle Text windows to display this data for each 

individual vehicle. Typically, due to limited display space, only one Vehicle Text window is 

visible. Also, because of the importance of the data available, the Vehicle Text window is 

typically left “on display” throughout a project. 

In the sample project, you will open only one Vehicle Text window.  

To Display the Vehicle Text window

1 Select View > Vehicle text. The Vehicle Text window displays at the bottom of the 

WinFrog display, as seen below. 

 

The Vehicle Text window configuration is saved in the WinFrogini.wfg file. Every time 

the Vehicle Text window is enabled, the same data are displayed in the same location of the 

window. By default, the Vehicle Text window is configured to display five rows and five 

columns of data. 

The data displayed in this window are also user-configurable to suit personal/operational 

preferences. Upon program shutdown, WinFrog will record this new Vehicle Text window 

configuration in the WinFrogini.wfg file. 

For our sample project, we will add an extra item (Line Bearing) as it is not among the 

default items automatically displayed in the window. 

To Configure the Vehicle Text Window 

1 Select Configure > Vehicle Text. (Or, move the mouse pointer within the Vehicle Text 

window limits and click the right mouse button and choose the Configure Vehicle Text 

option.) 

2 The Configure Vehicle Text dialog box displays with the Data Display Control area 

showing Line Contents on the left and the Available Items on the right, as seen below. 
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The Vehicle Text window is divided into five rows with Row 1 located at the top of the 

window and Row 5 at the bottom. The Line Contents window displays what data are 

displayed in the row displayed in the Row dropdown box. Change the Row to see its 

configuration in the Line Contents window. (See the Operator Display Windows chapter 

for definitions of the Available Items.) 

3 Select Row 5 from the Row dropdown box. By default, Line Name, Distance to SOL, 

Distance to EOL, and Port/Starboard data are displayed in this row. 

4 From the Available Items list (the list on the right side of the window), select Line 

Bearing, then click the left arrow to move Line Bearing from the Available Items list to 

the Line Contents list. 

5 Click OK to save the changes and close this dialog box.  

Note: the window spaces allocated for these data items will remain blank until there are 

data to display. 

Graphics Window/Display 
The Graphics window is the main navigational display generated by WinFrog. It is a real-time, 

scaled, plan view representation of the WinFrog positional data. It provides a graphical 

representation of the positions of all vehicles, as well as any Waypoints, Survey Lines, Picture 

Files, Charts, and Data Events. 

You can control the display of Parallels of Latitude and Meridians of Longitude, as well as 

Map Projection Northing and Easting gridlines. The Graphics window can be centered on a 

fixed point or follow any WinFrog vessel. The Rotation, Scale and Color of the Graphics 

display can also be configured to your preferences. 

For multi-vehicle applications, more than one Graphics window can be displayed to show the 

data for each vehicle. Each of the Graphics windows can be independently configured. 

In this sample project, you will display only one Graphics window and will configure it to 

display Survey Lines, Waypoints, a North Arrow, Projection and Geographic Grids, 

Working Data (.ALG) file contents, and Working Log (.LOG) file data. You will also 

configure the Graphics window to be oriented “North Up” and centered on the Locator 

vehicle. 
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To Display the Graphics Window 

1 Select View > Graphics. The Graphics window displays. 

 

By default, WinFrog will center the Graphics window on the first vehicle listed. Since we 

have only configured one vehicle, the Graphics window is centered on the Locator’s CRP. 

To Configure a Graphics Window 

1 Select the main menu item Configure > Graphics. (For a shortcut to the Configure 

Graphics menu, position the mouse pointer within the limits of the Graphics window, 

right-click and choose the Configure option.) 

The Configure Graphics window has eight tabs offering multiple options on each page. 

Only those items mentioned above will be addressed here. (For more information refer to 

the Operator Display Windows chapter). 
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2 Center - Click on the Center tab and select the Center on Vehicle radio button. The Re-

Center Percent indicates how far the vehicle can move from the center of the Graphics 

window before the display is re-drawn (and re-centered). The computer will slow down 

excessively if you enter a small value (less than say 50%). The default value of 80% is 

adequate for most applications. 

3 Rotation - Click on the Rotation tab. The default Manual Rotation Angle is set to 0.00.  

Note: When you are tracking a survey line, you will want to change this to Rotate to 

Survey Line. This will ensure that the Graphics display will be oriented so that the current 

survey line segment will be “straight up” on the display. This makes it easier for the vehicle 

pilot to keep the vehicle on line. 

4 Grids - Click on the Grids tab. The default settings have the Enable Projection Grid and 

Enable Geographic Grid options enabled. No changes need to be made for the sample 

project. 

5 Misc. - Click on the Misc tab. The Plot North Arrow option defaults to enabled status, as 

typically desired. 

6 Fix Data - Click on the Fix Data tab. The Plot Data Files and Plot Log Files default to 

enabled status, as typically desired. The colors ensure that the data will be visible on the 

black background of the graphics screen and can be edited as desired. 

7 Lines/Waypoints - Click on the Lines/Waypoints tab. The Plot Survey Lines and Plot 

Waypoints options default to enabled status, as typically desired. 
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Look at the other Configure Graphics options, paying particular attention to the Scale tab. 

The Zoom Factor is the amount that the scale will change each time you click the Zoom In 

or Zoom Out button on the toolbar. You might want to change this value later to slow 

down the zooming effect, depending upon your personal preferences. 

Because you haven’t yet created any survey lines or waypoints, or collected any Data, only 

the Vehicle, Grids, North Arrow and Scale are currently visible in the Graphics window. 

Graphics Display Zooming 
At different times throughout a survey you will want to see different areas of the Graphics 

display. Zoom Out to see a larger area at lesser detail or Zoom In to see a smaller area at 

greater detail. 

To Zoom Out 

• On the toolbar, click the Zoom Out button (the second button from the left on the toolbar, 

the icon of a magnifying glass with a minus sign to the right of it). Based on the Zoom 

Factor value entered when you configured the Graphics window (default factor is 2.0), the 

scale of it will be multiplied by that value each time this button is clicked. 

Notice that the vessel’s size does not change after you zoom out past a scale of 1:10000, 

which allows you to see the vehicle when at higher scales. This option is configurable in the 

Configure Vehicle > Name > 1:10000 limit option.  

You can also Zoom Out by placing the mouse pointer within the limits of the Graphics 

window then clicking the right mouse button. Select the Zoom Out option to Zoom Out once. 

To Zoom In 

• On the toolbar, click the Zoom In button (the first button from the left on the toolbar, the 

icon of a magnifying glass with a plus sign to the right of it). 

• You can also Zoom In by placing the mouse pointer within the limits of the Graphics 

window then clicking the right mouse button. Select the Zoom In option to Zoom In once. 

Vehicle Navigation in Simulation Mode 
As previously mentioned , this tutorial relies on Simulated Real-Time devices for the vehicle’s 

positioning, heading, and depth data. This section explains how to use the simulators to navigate 

the vessel. These skills are required later during Survey Line Tracking and Data Collection. 

To Change the Position of the Vehicle 

The coordinates for the project limits are defined on the sample project page. Since we had 

configured the Graphics window to be centered on the Locator vehicle, we must move the 

Locator to the same area so that we can see the work area. We will move the vehicle to 

approximately the center of the work area, at the following grid coordinates: N243 500, 

E6295500. 

1 Position the mouse pointer within the boundaries of the Vehicle Text window and click the 

right mouse button. Choose the Configure Vehicles option and then click the Configure 

Vehicle-Devices button when the Configure Vehicles window displays. 
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2 In the Position entry area of the window, highlight the Northing value and type N243500. 

Next, highlight the Easting value and enter E6295500. 

3 While still in the Configure Vehicle Calculations window, select the Update checkbox 

(immediately below the Copy button). 

4 Click OK and close the Configure Vehicles window. Notice in the Graphics window and 

the Vehicle Text window that the Locator has moved to the newly-defined position. 

Note: There is a shortcut to changing the vehicle’s position, detailed below. 

To Change a Vehicle’s Position Using the Display Position Feature 

1 First, ensure that only the Display Position button is highlighted in the button toolbar. 

 

Now, when you left-click anywhere on the Graphics window you will see a “cross” drawn 

at that point. The coordinates of that point are displayed in the lower status bar at the 

bottom of the screen (just below the Vehicle Text window) and also recorded in the 

Windows “clipboard memory”. 

2 To move the vehicle to the newly recorded position, repeat Step 1 of the previous steps (to 

open the Configure Vehicle-Devices dialog). Next, simply click the Copy button in the 

Position group at the top left corner of the dialog box. The mouse pointer coordinates are 

copied to the Position entry window and the Update option is automatically checked. Now 

click OK to make the Locator move to that position. 

Driving the Vehicle in Simulation Mode 

To Configure the Simulator 

WinFrog has simulator tools that allow you to “drive” the boat while sitting at your desk. By 

default, WinFrog has Turn Left (Port), Turn Right (Starboard), Speed Decrease, and Speed 

Increase buttons along the button toolbar, as seen below: 
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1 Select the main menu item Configure > Simulator to change the effect that the simulator 

buttons have on the vehicle. In the Configure Simulator dialog box you can specify the 

incremental values as desired. You may find the Heading increment more useful set to 1 

degree per mouse “click” rather than the default of 5 degrees. 

2 Click OK to close this window. 

You can observe the vehicle’s simulated Speed, Heading (and water depth) data updating in the 

Vehicle Text window. 

To Drive the Vehicle in Simulation Mode 

1 Zoom in sufficiently so that you can see the outline of the Locator in the Graphics window. 

2 Click on the Turn Right and Turn Left buttons, as needed, to steer the vessel. Each time 

you click on these buttons the heading will increase or decrease by the amount set in the 

Simulator Configuration. 

3 Click the Increase Speed button to send the Locator forward or the Decrease Speed 

button to slow the vessel.  

Note: If you click the Decrease Speed button too many times, the vessel will start moving 

backwards. 

Survey Lines and Waypoints 
During the planning stages of a typical survey, you are provided with the coordinates of the specific 

location (or limits of) the area to be surveyed. From these coordinates, you will prepare a series of 

“tracks” for the vessel to follow in order to collect data. In WinFrog, these tracks are called 

“Survey Lines”. Basically, Survey Lines are a series of points joined together to make a line. The 

Working Survey Line File can contain an unlimited number of individual survey lines. 

In addition to the survey lines, you may want to display and track various points of interest 

found in the survey area. These single points are referred to as Waypoints. You can enter as 

many waypoints into the Working Waypoint File as you like, but you can only track one 

waypoint at a time. 
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Survey Lines 
As mentioned above, a Survey Line is basically a series of points joined together in consecutive 

order to create a line. 

A Survey Line is made up of the following components: 

1 Start of Line (SOL) 

2 Points where the line direction changes, referred to as Alter Courses (A/Cs). A/Cs are also 

referred to as Segments in the Survey Line coordinate entry window. 

3 End of Line (EOL) 

You can create a Survey Line as long as you like, with as many A/C s as you wish. You can 

also add a Radius to a point to create a curved line. The line color can also be modified to help 

differentiate one line from another. 

All Survey Lines are stored in the Working Survey Line (.PTS) file. Each Survey Line in the 

file is treated independently, identified by a user-entered name.  

Note: it is possible, but not advisable, to have two lines with the same name in the same 

Working Survey Line file. 

Once a Survey Line has been defined in the Working Survey Line file, it can then be 

displayed in WinFrog’s Graphics window. You can also track any survey line with any 

WinFrog vehicle. Once you have selected which survey line to track, WinFrog calculates such 

information as distances from the SOL and EOL, as well as cross-track distance (perpendicular 

to the survey line). This information can then be displayed in various WinFrog windows to 

assist the helmsman in keeping the vessel on course. (See the Operator Display Windows 

chapter of the WinFrog User’s Guide for more information on displaying Line Tracking 

information). 

Note: A vehicle can track only one Survey Line at a time. Multiple vehicles can track the same 

(or different) Survey Lines simultaneously. 

To Create New Survey Lines 

1 From the File menu, click Edit Working Files... > Survey Lines. 
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WinFrog opens the Proj1.PTS dialog box because you had earlier specified Proj1.PTS to 

be the Working Survey Line file (File > Select Working Files). The file is empty at 

startup. 

2 Click the Add button. 

 

3 Type Line1 in the Name field at the top of the Survey Line dialog box. 

4 Make sure Segment0 is selected in the Line Segments area. 

5 You can enter coordinates in either Geo or Grid coordinates. In our example, we were 

provided with Grid coordinates. We defined units (Configure > Units) during 

configuration so the Coordinate defaults to Grid in this window. 
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6 Highlight the value beside the “N” in the Coordinate entry window.  

The sample provided coordinates for the Northwest and Southeast limits of the site. We will 

create survey lines that are oriented North to South within these limits. 

7 For the first coordinate, type in a Northing of 244000. (The full entry should read “N244000.”) 

8 Highlight the value beside the “E” in the Coordinate entry window. 

9 Enter 1734000. You’ve just defined the North end of Line1.  

10 Select Segment1 in the Line Segments area. 

11 Highlight the value beside the “N” in the Coordinate entry window. 

12 Enter 243000. 

13 Highlight the value beside the “E” in the Coordinate entry window. 

14 Enter 1734000. You’ve just defined the South end of Line1. 

Note: The order in which the coordinates are entered is significant because it determines the 

direction of the survey line, as well as which side of the line will be considered the Starboard 

and Port side of the survey line. The significance of this will be apparent when you create other 

survey lines parallel to this survey line and when you enable Survey Line Tracking. 

15 In the SOL (Start of Line) Event part of the window, enter 100 in the Number window 

and 0.0 in the Downline Distance window. These are default values that will appear when 

you start recording Automatic Events. 

16 Click OK to close the Survey Line window. Note that Line1 has now been added to the 

contents of Proj1.PTS 

To create other survey lines, you would just repeat this process, giving the new survey lines 

unique names. You can edit existing lines to add new segments or curves to them. For this 

project, you will create survey lines parallel to Line1. You could do this manually, by repeating 

the above process, but it is quicker to use WinFrog’s Parallel Lines function. 

To Create Survey Lines Parallel to an Existing Survey Line 

You must now create more Survey Lines to fill up the survey area defined by the client. 

Remember that the client specified that the survey lines be spaced 20.0 feet apart. You must 

complete a simple calculation to determine how many lines will be required to fill the area. In 

this case, the survey lines are running true North to South, so we can simply subtract the lesser 

Easting from the greater Easting to get the East-West dimension. (1734000.00-

1733000.00=1000.00 feet) Now, by dividing 1000.00 feet by the 20 foot spacing, we know the 

number of survey lines we’ll need equals 50. 

Because we entered the survey lines from the North end to the South end, North to South is now 

considered to be the survey line’s “forward” direction. This means that when we create other 

survey lines, parallel to this one, we must put in a negative offset value to have them be created 

to the left (East) of the chosen line. 

1 With the Proj1.PTS dialog box still open (Edit Working Files...Survey lines), select 

Line1 (if it is not currently selected). 
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2 Click the Parallel Lines button at the bottom of the dialog box. 

 

Because Line1 was highlighted when you clicked the Parallel Lines button in the 

Proj1.PTS dialog box, the line that you’re about to create will be parallel to Line1. If there 

were other lines available to choose from in the Proj1.PTS dialog box, you could have 

selected one of those and you would be creating a new survey line parallel to that one. 

3 Highlight the Offset field. 

4 Type -20. 

5 Highlight the Multiple field. 

6 Type 50. 

This specifies that you will create fifty survey lines twenty feet to the port side of Line1. In 

WinFrog, Starboard offsets are entered as Positive values and Port offsets are entered as 

Negative values. If you had created Line1 from South to North instead of from North to 

South, then Line1 would be oriented in the opposite direction and you would have entered a 

positive offset to create the fifty parallel survey lines in the correct location (to the east of 

Line1). 

7 Click OK to close the Parallel Line creation window. You’ve just created fifty new survey 

lines. Note the names of the new survey lines. WinFrog takes the original survey line name 

and appends it with the offset value. You can now highlight and edit any of these as you 

wish. 

8 Click OK to close the Proj1.PTS dialog box. Notice that the survey lines now appear as 

green lines in the Graphics window. 

Waypoints 
A “waypoint” is a single point of specific interest. For example, a waypoint could be the 

position of a shoal, a shipwreck, a pier, etc. WinFrog can be configured to calculate and display 

the Range and Bearing from a vehicle’s Tracked Offset to a waypoint. As the vehicle moves, 

WinFrog automatically re-calculates the Range and Bearing and updates the vehicle 

information in the Vehicle Text window. 

You can also configure WinFrog to sound an Alarm if the vehicle gets within a certain distance 

of a waypoint or if the vehicle gets a certain distance away from a waypoint. 

The Working Waypoint (.wpt) file can contain hundreds of waypoints.  
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To Create New Waypoints 

1 From the File menu, click Edit Working Files... > Waypoints. 

 

WinFrog opens the Proj1.WPT dialog box because Proj1.WPT is the name you originally 

gave the Working Waypoints File.  

2 Click the Add button. 

 

3 In the Name field, type Shoal. 

4 Because we were provided with Grid coordinates and set those in the configuration, the 

Grid radio button should already be selected by default. 

5 Highlight the value beside the N in the Position field. 

6 Type 243500. 
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7 Highlight the value beside the E in the Position field. 

8 Type 1733500. 

9 We will enter an Elevation as well, although this is not always required. Note that you are 

entering an Elevation, so depths must be entered as negative values. Enter a value of -5.0 ft.  

Entering an elevation value allows you to see the point in its correct vertical position in 

WinFrog’s Profile Window. (See the Operator Display Windows chapter in the WinFrog 

User’s Guide for more information on the Profile Window.) 

Entering an elevation will not affect the Range calculated to the waypoint because this is 

always the Horizontal distance value. 

10 In the Circle Radius field, highlight 0.00.  

11 Type 20. This instructs WinFrog to draw a circle of 20 feet radius around the waypoint in 

the Graphics window. Note: this is simply for graphical purposes, and not an alarm radius. 

A radius alarm will be configured below. 

12 In the Icon field dropdown menu select Rock. This instructs WinFrog to draw a unique 

icon at the defined coordinates. This helps identify the waypoint in the Graphics window. 

13 Edit the color as desired. Again, this will help identify the waypoint in the Graphics 

window. 

14 In the Waypoint dialog box, click OK. The Shoal waypoint is now added to the Working 

Waypoint file. If necessary, repeat these steps to add more waypoints in a similar manner. 

15 When finished adding Waypoints, click OK to close the Proj1.WPT dialog box. 

The Shoal now appears in the Graphics display at the specified coordinates. 

Tracking a Waypoint 
Now that you’ve identified where a potential hazard is, you’ll want WinFrog to warn you if 

Locator comes too close to this location. 

To Track a Waypoint 

1 With the mouse pointer in the Vehicle Text window, click the right mouse button and select 

the Setup Waypoint Tracking option. The Setup Waypoint Tracking dialog box opens, 

as seen below: 
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2 In the Waypoint Position area, click the Waypoint File radio button. 

You now select the waypoint that you want to track. In this case, there is only one waypoint 

in the Working Waypoint File (Shoal), so it automatically appears in the dropdown menu. 

3 In the Alarm area, click the Enter radio button. This specifies that the alarm will sound 

when the vehicle enters the specified distance. 

4 Enter 50 in the Radius field. 

5 Click OK. 

The Name of the Waypoint, along with the Range and Bearing from the Locator, now 

appears in the Vehicle Text window. Now, if Locator approaches within twenty feet of the 

shoal, an alarm will sound. 

Notice that the waypoint is now displayed in the same color as Locator, the vehicle 

tracking that waypoint. This lets you know which vehicle is tracking which waypoint in the 

Graphics window. 

Collecting Data:  Events 
During a survey, you will want to record information concerning the vehicle’s position, speed, 

heading, course made good/course over ground, water depth, etc. This information can be 

recorded automatically at a set time or distance downline interval or manually at the click of a 

button. Regardless of how the collection of data is initiated (automatically or manually), the 

actual instant that data is recorded is termed an “event.” 

When Eventing is activated, WinFrog writes various types of information to files. In 

hydrographic surveying, the term fix is used to represent the same event. In seismic operations 

the term shotpoint is used. The three terms are used interchangeably in WinFrog. 

The following sections detail Automatic and Manual Eventing in WinFrog. 
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Automatic Eventing 
WinFrog can be configured to Automatically generate an Event at a given Time or Distance 

interval, recording the following information: 

Event Number 

Vehicle Name 

Position 

Time and Date 

Height 

Depth 

Layback 

Speed 

Heading 

Course Made Good/Course Over Ground 

Offset 

QC - Quality Control value 

Alongline Distance 

Offline Distance 

KP value 

Raw Data 
In addition to the above-mentioned Event information, WinFrog can be configured to 

automatically record “Raw” data from interfaced peripheral I/O Devices. 

There is an important difference between event data and raw data. The data recorded in 

Automatic or Manual Event files may have geodetic offsets, positional offsets, tracking 

offsets, and positional filtering applied, whereas, Raw data has no offsets or filtering applied. 

Raw data allows you more freedom in processing because you have better knowledge of the 

status of the data. Raw I/O Device data is written to a .raw file, which is distinctly different 

from Automatic or Manual Event data files. The .raw ASCII files contain a line-by-line list of 

all of the data from each individual device that is interfaced to WinFrog, logged record-by-

record, and preceded by an identifying Device Code, the Name of the device, and a Time-

Stamp. 

You have the ability to record raw data at varying intervals: With Events, At Events, and 

Always. 

Recording raw data “With Events” means that raw data will be recorded for the entire time that 

Automatic Eventing is active. In other words, it does not matter what kind of recording 

interval has been set, raw data will be collected from the instant that eventing is made Active to 

the moment you disable Automatic data collection. 

Recording raw data “At Events” means that raw data will be recorded only at those instants 

when an Automatic Event is taken. In other words, if you have set WinFrog to record an event 

every 10 seconds, raw data will also be recorded only at those same 10 second intervals. 
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Recording raw data “Always” means that raw data will be recorded from the instant that you 

select OK to close the Event Configuration window. Recording raw data Always does not 

require Automatic Eventing to be enabled. 

Note: It is strongly suggested that you record raw data during a project as a backup to 

automatic or manual event data. 

Manual Fixing 
You can manually tell WinFrog to record an event by clicking on a button, recording the 

following information: 

User-Entered Comment 

Vehicle Name 

Position 

Time and Date 

Height 

Depth (of water) 

Layback 

Speed 

Heading 

Course Made Good/Course Over Ground 

Offset 

Quality Control value 

Alongline Distance 

Offline Distance 

KP - (Kilometer Post value. The distance downline in kilometers) 

Both Automatic and Manual Eventing can be used together. For example, you can configure 

WinFrog to record Automatic Events at a set time or distance interval while you also 

simultaneously record Manual Events by clicking a button. There are three ways to generate a 

Manual Event: select Configure > Manual Event, hit the F10 key, or click on the Manual 

Event button, as seen below. 

 

Regardless of which method is chosen to initiate a Manual Event, the same Manual Event 

dialog box opens, as seen below. 
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Type in a Comment to describe the Manual Event. This should be a unique comment to help 

easily identify this event. If you want to record only one vehicle’s position, select that vehicle 

name from the dropdown menu, then select the Only selected vehicle checkbox. Select OK to 

close this window and save the Manual Event. Manual Events are recorded in the Working 

Logs (.log) file. 

You can access the contents of the Working Logs File at any time by selecting the main menu 

item File > Edit Working Files... > Logs. Highlight any entry and select Edit to review the 

information recorded for that particular Manual Event. 

Configuring a Vehicle for Automatic Events 
In order to configure WinFrog to automatically record event data, you must define one vehicle 

as the Event Primary vehicle. The information for any number of vehicles can be recorded 

using automatic events, however, only one vehicle (the Event Primary vehicle) can trigger 

them. If you want to record information for any other configured vehicles, the additional 

vehicles must be configured as Event Secondary vehicles. 

When the Event Primary vehicle triggers an event, information for that vehicle (along with all 

Event Secondary vehicles) will be recorded to one of three Record types, as defined by the 

user. Regardless of the Record Type chosen (be it .DAT, .SRC, or .RCV), this file will contain 

the following information: 

Event Number 

Vehicle Name 

Position 

Time and Date 

Height 
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Water Depth 

Layback 

Speed 

Heading 

Course Made Good/Course Over Ground 

Offset 

Quality Control value 

Alongline Distance 

Offline Distance 

KP (Kilometer Post) value 

 

To Define the Event Primary Vehicle 

1 Select the main menu item Configure > Vehicles then click the Vehicle Presentation 

button. 

2 In the Event Generation area, click the Event Primary radio button. 

 

3 Click OK to close the Vehicle Presentation dialog box. 

Configuring Automatic Events 
Now that you’ve notified WinFrog that Locator is the vehicle that will trigger events, you need 

to tell WinFrog how you want the events to be triggered. In our sample project, we will record 

data at the client-specified interval of 20 feet along the survey line. 

Before we start eventing, we should move the boat outside of the survey line area, somewhere 

near to N244500, E1734000. This will ensure that eventing will not inadvertently start before 

we are ready. (See the section above for details on moving the vessel). 
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To Configure Automatic Events  

1 Select the main menu item Configure > Data Events > Setup, or right click in the Vehicle 

Text window and select the Setup Data Events option. 

2 In the Trigger area of the Event Configuration window, click the Distance radio button.  

 

3 Highlight the value in the Interval window and type in 20.0 feet. 

4 In the Record Type area, select the Hydrographic (.DAT) radio button to create a data file 

with a .DAT file extension. The Hydrographic Record Type is chosen because it (as well 

as Source (.SRC) and Receiver (.RCV) record types) automatically requests that a Survey 

Line be subsequently selected, which is what we require for our sample project. 

5 At the bottom of the Event Configuration dialog box, in the Event Start area, click the 

Auto Start radio button. This instructs WinFrog to go directly to Eventing Active, as 

opposed to going to Eventing Enabled first. If you chose Manual Start, you must 

manually activate eventing. (More details on this in the Data Collection section below.) 

With Eventing Active, our data recording will start when the vehicle crosses the beginning 

of the survey line. 

6 In Event #Control, click Line. This tells WinFrog that we desire the Event Numbers 

along every line to default to the same number at their respective SOLs. Remember that this 

is just a default which can be changed when we configure eventing, as you’ll see shortly. 
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7 Select the Raw Data tab, then in the Logging Control section of the window, click the 

With Events radio button. This instructs WinFrog to record all raw data received from 

peripheral devices for the duration of automatic event data recording. 

8 In the Raw File Control section, click the Use Julian Date/Time radio button and leave 

the Max File Size in KB set to 200. These settings tell WinFrog to store the raw data in a 

file named after the Julian date (1 through 365 Julian days in a year)and time. For example, 

a .raw file recorded at 9:00am on September 27, 1999, would be written as 270-0900.raw 

and would be a maximum of 200KB in size. Once the specified file size has been reached, 

another .raw file would be automatically created by WinFrog, again reflecting the date/time 

in its name. 

Creating multiple .raw files offers a degree of safety in that if all .raw data were recorded 

to a single file and that file was somehow corrupted, all data would be lost. Also, depending 

on the number of devices and the amount of data collection undertaken, a single .raw file 

may reach an unwieldy size. For example, in a typical survey (using just a GPS receiver, 

gyro, and an echosounder) a new 200 KB file is created every two minutes when either raw 

with events or raw always is used. 

9 The Raw Navigation Record (Type 300) window refers to the generation of a data record 

that is not typically required.(This record compiles raw data from some of the I/O devices to 

a new, single Type 300 record in the .raw file). For this sample project (and most “real” 

projects) the Logging Interval can be left at the 0.00 sec default value. 

10 Click OK to close the Event Configuration window. As mentioned previously, the 

Distance Fixing dialog box now opens automatically because we had chosen the 

Hydrographic Record Type. 
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11 You must now select which survey line to track. As mentioned above, Eventing on 

Distance requires that a survey line be tracked.  

Important: The Event Distance Interval is not necessarily the distance that the vessel 

travels, but is the downline distance of the tracked survey line. For example, if the vessel 

travels at a right angle to the direction of the survey line, no events will take place. Also, 

note that no events will take place until the vessel’s Tracked Point crosses the start of the 

Survey Line. 

Select Line1 and Forward. Forward means that the Start of Line is the point that was 

entered first when you created the survey line. 

12 The Event Filename entry is used to define the name of the .dat file that will be created. 

WinFrog uses the survey line name by default. You would typically leave this as is. 

Enter a Filename Prefix if you are re-shooting the line and do not want to overwrite or 

append an existing file of the same name. 

13 In the Event Number Interval grouping, type 1 and select the Increment option. 
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14 In the Start of Eventing > Event #at SOL window you will see 100, which is the value 

that you entered as the SOL Event Number when you created the survey lines. Ensure that 

the Distance Downline of SOL is 0.00 and that the Start of Data Logging Event # is 100. 

This means that data logging will start at the beginning of the line with event number 100. 

These options are for those situations when you want to start data recording at some point 

other than the start of the survey line. 

15 In the Run-In / Run Out Events window, set both values to 0. This defines additional 

events at the start and end of the survey line. 

16 In the Graphics Extension window, select On and enter a length of 500 feet. This instructs 

WinFrog to draw a 500 foot long dashed line before the actual (defined) start of the Survey 

Line. This extra distance gives the pilot a chance to get the boat lined up and steady on the 

survey line before data recording begins. 

17 Click OK data to close the Distance Fixing dialog box. Eventing is now Active. 

Eventing is Active 
Several things are different on your screen. In the button toolbar, the Event Stop button is now 

highlighted in red.  

 

In the Graphics window, the survey line that you are tracking, Line1, is now the color of the 

vehicle that is tracking that line. 

In addition to the general navigation data that was previously displayed, the first line on the 

Vehicle Text window indicates that Eventing Status (EVT ACTIVE), the Active Fix 

Number (FIX 100), and the File Name (File Line1.DAT). 

The second line shows the Raw Record Status (Raw With Events). 

The fifth line indicates which Survey Line is being tracked (Line1), the (downline) distance 

Locator is from the Start of Line, the (downline) distance Locator is from the End of Line, 

and the perpendicular distance Locator is off the survey line to Port or Starboard. 

Although the Eventing mode is Active, we are not actually recording data yet. We must be 

between the Start of Line and the End of Line for this to happen. Before we start eventing, 

we’ll enable and modify some WinFrog features to help the pilot keep the Locator on line. 

Tracking up the Screen 
It’s a lot easier for the helmsman to keep the boat on course if the Graphics display is 

configured so that the outline of the vehicle tracks straight “up” the screen, instead of constantly 
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trying to refer to which way is North and which way the boat is heading. 

You can change the orientation of the Graphics display by changing its Rotation. You can tell 

WinFrog to rotate to the active survey line segment or you can enter any rotation you wish 

(measured in degrees clockwise from North). 

To Change the Rotation of the Graphics Display 

1 From the Configure window, choose Graphics. 

2 Select the Rotation tab and choose Survey Line in the Rotate to area. 

3 In this case, since the survey line coordinates were entered from North to South and we are 

tracking the survey line in this forward direction, the Graphics screen will now flip the 

graphics to have South at the top of the screen.  

4 Click OK. Notice the shift in the Graphics window, including the direction of the North 

arrow. 

Attitude 
Another display that your helmsman can find useful for keeping the vehicle on course is the 

Attitude window. 

To View the Attitude Display 

1 From the View menu, choose Attitude. 

 

This window provides a graphical representation of the vessel’s navigation parameters with 

comparisons of the Vehicle’s Heading (green), the Vehicle’s Course Made Good (blue), 

and the Bearing of the Survey Line (red). 

There is also a horizontal bar graph indicating the Offtrack Distance. The slider bar at the 

bottom of the screen can be used to change the Scale. A vertical bar graph in the left portion 

of the Attitude window indicates Vessel Speed. 

The Attitude window is very useful for Survey Line tracking operations. It often proves to 

be a better tool for the helmsman to maintain tracking rather than trying to find the 

information in the Vehicle Text window. 
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Starting to Record Automatic Events with Autostart 
With Autostart activated (as it is now in your sample project), automatic eventing commences 

when the vehicle crosses the beginning of the Survey Line. 

To Record Automatic Events with Autostart Activated 

1 Using the menu bar Simulated Heading button, turn the Locator’s heading to 180.0 to 

match the survey line’s heading. 

Click on the menu bar Simulated Speed Increase button to start the Locator moving 

downline at approximately. 4 knots. 

In the Graphics display, Zoom in to a scale to make it easy to navigate the Locator along 

Line1 (ratio of approximately 1:2000). 

Note: the SOL value is currently a negative value and is getting closer to zero as you 

approach the Start of Line. Regardless of how far offtrack you are, when the SOL value 

reaches 0.0, eventing will start. 

All displayed position and survey line tracking information refers to the Vehicle Offset 

point being tracked. As detailed above, for our exercise we have configured WinFrog to 

track an offset called Echo Sndr. This means that eventing will not start until that point on 

the ship crosses over the SOL. 

2 Watch the Graphics window while Locator automatically records events. You can zoom 

in or zoom out to obtain a clearer view of the data. The individual Data Events will be 

discernible as yellow, fix-number-labeled squares. 

Keep the Locator within a reasonable offtrack distance by watching the Graphics screen, 

Attitude window, and the Vehicle text window and adjusting the vehicle’s Heading to suit. 

Continue down to pass the end of the survey line. 

Stopping/Re-starting Eventing 

To Stop Eventing 

1 You can click the red Event Stop button (in the toolbar) to cease recording events at any 

time, but for our example, wait until the vehicle has crossed the EOL to stop data 

collection.  

To Re-start Eventing 

By default, WinFrog will return you directly to the Distance Fixing dialog box. This is done 

under the assumption that you will want to collect data using the same parameters used on the 

line just completed. In our case, we had eventing based on a Distance of every 20 feet and 

collection of Raw Data with Events. If you do not wish to record any more data, you would 

select the Cancel button at this point. For our example, we will setup the vessel to collect data 

going down another survey line, this time in the opposite direction. 

1 Select a different survey line from the one last used. You will have to configure the survey 

line tracking to be Reverse to now track it in the opposite direction. When you select 

Reverse, WinFrog automatically calculates the appropriate Starting Event Number and 
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also selects the Decrement option. These are calculated to make the event numbers for all 

survey lines match up. In other words, all of the event numbers on each of the survey lines 

will line up across the Graphics screen. 

Note: as you select OK to close the Distance Fixing window, Eventing Status is now 

Enabled, not Active. You must now press the green Event Start button (just to the left of 

the Event Stop button) to change the status to Event Active. Failure to do so will result in 

no data being collected. 

Notice that the SOL is now the South end of the survey line. Navigate the Locator to the 

SOL and beyond, collecting data while navigating along the survey line. 

Checking the Survey Data 
It is wise to check early on in the survey that data are in fact being recorded, that the files 

contain the desired information, and that data are being recorded at the desired rate. Remember 

that we had configured WinFrog to record both automatic event (.DAT) and raw (.RAW) data 

during eventing. You should check to ensure that both types of data are being recorded and at 

the rate of recording that you intended. 

To Check the Recorded (.DAT) Data 

1 Select File > Edit Working Files.... > Data. This will bring up a display showing you the 

contents of the Working Data (.ALG) file. The .ALG file is basically just a directory 

listing the names of the recorded .DAT files. 

2 Highlight any one of the .DAT file names in the .ALG file and select Edit. You will now 

see the contents (i.e. the individual events) contained in that individual .DAT file. 

3 Highlight any one of the individual events and select the Edit button. You now see the 

information for that specific event including Position, Time, Speed, Heading, CMG, and 

Survey Line tracking information. 

To Check the Raw (.RAW) Data 

Earlier in this exercise, you specified where the .raw data would be written to on the hard drive. 

This was done under File > Select Working Directories > Raw Data Directory. In order to 

check this data: 

1 Navigate to the Raw Data Directory. 

2 Open one of the .raw files using an editing program. The easiest way to do this is to 

associate the raw file with the program WordPad or NotePad. 

Once you open a .raw file (which is simple a comma delimited ASCII text file), read the 

individual lines to ensure that a record exists for each type of device that was added to the 

vehicle, and that the data being received from the device are realistic. In particular, look out 

for “zero data.” Occasionally certain I/O devices output data containing nothing but zeros, 

which obviously isn’t what you want. The .raw files are admittedly rather cryptic in nature, 

but you should be able to figure out if the correct number of devices are there and if the data 

from each device is more than just “zero data.” 
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Completing the Survey 
Essentially, you repeat these data collection steps until your survey is complete. The most 

common mistake made is forgetting to select the correct tracking direction each time a new 

survey line is selected. In other words, making sure that if the currently selected survey line is 

being tracked in the Forward direction, the next survey line must be tracked in the Reverse 

direction. 

 


